
 
                               
                                ISSN (Print)  : 2320 – 3765 
                                ISSN (Online): 2278 – 8875 

 

International Journal of Advanced Research in  Electrical, 
Electronics and Instrumentation Engineering 

(A High Impact Factor, Monthly, Peer Reviewed Journal) 

Website: www.ijareeie.com  

Vol. 7, Issue 3, March 2018 
 

Copyright to IJAREEIE                                                         DOI:10.15662/IJAREEIE.2018.0703033                                           1242  

A High Efficient Multiinput Multioutput  
DC-DC Boost Converter for Electrical Vehicle 

Application 
 

Priyanga.S M.E, Ramkumar ME,  

Dept. of Power Electronics and Drives, Mahendra College of Engineering, Namakkal, India 

Assistant Professor, Dept. of Electrical and Electronics Engineering, Mahendra college of engineering, Namakkal, India 

 
ABSTRACT: A new non isolated multiinputmultioutput dc–dc boost converter is proposed in this paper. This converter 
is applicable in hybridizing alternative energy sources in electric vehicles. The proposed converter has several outputs 
with different voltage levels which makes it suitable for interfacing to multilevel inverters. Using of a multilevel inverter 
leads to reduction of voltage harmonics which reduces torque ripple of electric motor in electric vehicles. The proposed 
converter has just one inductor.  The validity of the proposed converter and its control performance are verified by 
simulation and experimental results for different operation conditions. 
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I. INTRODUCTION 
 
Increasing rapidly population and energy consumption   in the world, increasing oil and natural gas prices, and the   
depletion of fossil fuels are justifiable reasons for using electrical   vehicles (evs) instead of fossil-fuel vehicles. The 
interest   in developing the evs with clean and renewable energy sources   as a replacement for fossil-fuel vehicles has 
therefore steadily   increased. The evs are proposed as a potential and attractive   solution for transportation applications 
to provide environmentally   friendly operation with the usage of clean and renewable   energy sources.  In the evs, the 
fuel cell (fc) stack usually   used as clean energy source. The fcs are energy sources   that directly convert the chemical 
energy reaction into the electrical   energy. Currently, fcs are acknowledged as one of the   promising technologies to 
meet the future energy generation requirements. Fcs generate electric energy, rather than storing it, and continue to 
deliver the energy, as long as the fuel supply is maintained. However, there are some well-known technical limitations to 
FCs: they have slow power transfer rate in transitory situations, and a high cost per watt. This case is the reason for 
which FCs are not used alone in the EVs to satisfy the load demands, particularly during startup and transient events. So, 
in order to solve these problems, usually FC is used with energy storage systems (ESSs) such as batteries or 
supercapacitor (SC). Furthermore, the association of FC and ESSs leads to a reduction of the hydrogen consumption of 
the FC. FC    and ESSs such as battery and SC have different voltage levels.    So, to provide a specific voltage level for 
load and control power flow between input sources, using of a dc–dc converter for each of the input sources is need. 
Usage of a dc–dc converter for each of the input sources leads to increase of price, mass,and losses. Consequently, in 
hybrid power systems, multiinput dc–dc converters have been used. Multiinput converters have    two main types, 
isolated multiinput dc–dc converters and no isolated    multiinput dc–dc converters. In thefollowingsections,two main 
types of multiinput converter are 
investigated.basedconvertersbeforetobeappliedtotheprimarysideoftheHFtransformer.Theoppositeprocessisperformedonth
eHFtransformersecondaryside to obtain anAC and/orDC voltage forthe load. 
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II.EXISTING SYSTEM 

 
 

 
 
The existing diagram is shown in fig1. 

The Existing System the voltage balancing controls methods for three-level boost-type converter. The Existing sampling 
strategy, the information of the AC power and the voltage imbalance can be provided for the proposed control methods. 
The AC power PAC is the product of the AC current I AC and the AC voltage v AC. By neglecting the power loss of the 
three level boost converter, the PV power can also be expressed as the product of the dc-bus voltage Vdc. 

 
The block diagram is shown in fig2 

 
III. DC-DC CONVERTERS 

 
A DC to DC converter is a device that accepts a DC input voltage and produces a Dc output voltage. Typically 

the output produced is at a different voltage level than the input. In addition, DC to DC converters are used to provide 
noise isolation power bus regulation; etc. DC-DC converters are mainly classified into four topologies. They are 
�Buck converter 
�Boost converter 
�Buck boost converter 
�Cuk converter 
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 BUCK BOOST CONVERTER 
 

Two different topologies are called buck–boost converter. Both of them can produce an output voltage much 
larger (in absolute magnitude) than the input voltage. Both of them can produce a wide range of output voltage from that 
maximum output voltage to almost zero. The inverting topology – The output voltage is of the opposite polarity as the 
input buck (step-down) converter followed by a boost (step-up) converter – The output voltage is of the same polarity as 
the input, and can be lower or higher than the input. Such a non-inverting buck-boost converter may use a single 
inductor that is used as both the buck inductor and the boost inductor. 
 

The buck–boost converter is a type of DC-to-DC converter that has an output voltage magnitude that is either 
greater than or less than the input voltage magnitude. It is a switched-mode power supply with a similar circuit topology 
to the 
boost converter and the buck converter. The output voltage is adjustable based on the duty cycle of the switching 
transistor. One possible drawback of this converter is that the switch does not have a terminal at ground; this complicates 
the driving circuitry. 
Also, the polarity of the output voltage is opposite the input voltage. Neither drawback is of any consequence if the 
power supply is isolated from the load circuit (if, for example, the supply is a battery) as the supply and diode polarity 
can simplybe reversed. The switch can be on either the ground side or the supply. 

 
General circuit diagram 

 
Principle of operation 
 

The two operating states of a buck–boost converter: When the switch isturned-on, the input voltage source 
supplies current to the inductor, and the capacitorsupplies current to the resistor (output load). When the switch is 
opened, the inductor 
supplies current to the load via the diode D.The basic principle of the buck–boost converter is fairly simple� 
.While in the On-state, the input voltage source is directly connected to theinductor (L). This results in accumulating 
energy in L. In this stage, thecapacitor supplies energy to the output load. 
�While in the Off-state, the inductor is connected to the output load andcapacitor, so energy is transferred from L to C 
and R. 
�Compared to the buck and boost converters, the characteristics of the buck–boost converter are mainly, Polarity of the 
output voltage is opposite to that ofthe input. 
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�The output voltage can vary continuously (for an ideal converter). The outputvoltage ranges for a buck and a boost 
converter are respectively 0 to inf. 
 
 

. 
operational diagram of Buck boost converter 

 
Continuous Mode 

 
Operation of buck boost converter in continuous mode. 

 
If the current through the inductor L never falls to zero during a commutationcycle, the converter is said to 

operate in continuous mode. From t=0 to t=DT, theconverter is in On-State, so the switch S is closed. The rate of change 
in the inductorcurrent (IL) is therefore given by,During the Off-state, the switch S is open, so the inductor current 
flowsthrough the load. If we assume zero voltage drop in the diode, and a capacitor largeenough for its voltage to remain 
constant, the evolution of IL is:As we consider that the converter operates in steady-state conditions, theamount of 
energy stored in each of its components has to be the same at thebeginning and at the end of a commutation cycle. This 
in return yields thatFrom the above expression it can be seen that the polarity of the outputvoltage is always negative (as 
the duty cycle goes from 0 to 1), and that its absolutevalue increases with D, theoretically up to minus infinity as D 
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approaches 1. Apartfrom the polarity, this converter is either step-up (as a boost converter) or step-down(as a buck 
converter). This is why it is referred to as a buck–boost converter. 
 
Discontinuous Mode 
 

In some cases, the amount of energy required by the load is small enough tobe transferred in a time smaller than 
the whole commutation period. In this case, thecurrent through the inductor falls to zero during part of the period. The 
onlydifference in the principle described above is that the inductor is completely 
discharged at the end of the commutation cycle. Although slight, the difference has astrong effect on the output voltage 
equation. It can be calculated as followsDuring the off-period, IL falls to zero after δ.TUsing the previous equation, δ 
isTherefore, the output voltage gain can be written as:Compared to the expression of the output voltage gain for the 
continuous mode, thisexpression is much more complicated. Furthermore, in discontinuous operation, theoutput voltage 
not only depends on the duty cycle, but also on the inductor value, theinput voltage and the output current. 
 

IV. PID CONTROLLER 
 
A proportional-integral-derivative controller (PID controller) is a control loop feedback mechanism (controller) widely 
used in industrial control systems. A PID controller calculates an error value as the difference between a 
measured process variable and a desired set point. The controller attempts to minimize the error by adjusting the process 
through use of a manipulated variable. 
The PID controller algorithm involves three separate constant parameters, and is accordingly sometimes called three-
term control. the proportional, the integral and derivative values, denoted P, I, and D. Simply put, these values can be 
interpreted in terms of time: P depends on the present error, I on the accumulation of past errors, and D is a prediction 
of future errors, based on current rate of change.The weighted sum of these three actions is used to adjust the process via 
a control element such as the position of a control valve, a damper, or the power supplied to a heating element. 
In the absence of knowledge of the underlying process, a PID controller has historically been considered to be the best 
controller. By tuning the three parameters in the PID controller algorithm, the controller can provide control action 
designed for specific process requirements. The response of the controller can be described in terms of the 
responsiveness of the controller to an error, the degree to which the controller overshoots the set point, and the degree of 
system oscillation. Note that the use of the PID algorithm for control does not guarantee optimal control of the system or 
system stability. 

Some applications may require using only one or two actions to provide the appropriate system control. This is 
achieved by setting the other parameters to zero. A PID controller will be called a PI, PD, P or I controller in the absence 
of the respective control actions. PI controllers are fairly common, since derivative action is sensitive to measurement 
noise, whereas the absence of an integral term may prevent the system from reaching its target value due to the control 
action. 
 

V. PULSE-WIDTH MODULATION 
 
Pulse-width modulation (PWM), or pulse-duration modulation (PDM), is a commonly used technique for controlling 
power to inertial electrical devices, made practical by modern electronic power switches.The average value of voltage 
(and current) fed to the load is controlled by turning the switch between supply and load on and off at a fast pace. The 
longer the switch is on compared to the off periods, the higher the power supplied to the load is.The PWM switching 
frequency has to be much faster than what would affect the load, which is to say the device that uses the power. 
Typically switchings have to be done several times a minute in an electric stove, 120 Hz in a lamp dimmer, from few 
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kilohertz (kHz) to tens of kHz for a motor drive and well into the tens or hundreds of kHz in audio amplifiers and 
computer power supplies. 
The term duty cycle describes the proportion of 'on' time to the regular interval or 'period' of time; a low duty cycle 
corresponds to low power, because the power is off for most of the time. Duty cycle is expressed in percent, 100% being 
fully on. The main advantage of PWM is that power loss in the switching devices is very low. When a switch is off there 
is practically no current, and when it is on, there is almost no voltage drop across the switch. Power loss, being the 
product of voltage and current, is thus in both cases close to zero. PWM also works well with digital controls, which, 
because of their on/off nature, can easily set the needed duty cycle.PWM has also been used in certain 
communicationsystems where its duty cycle has been used to convey information over a communications channel 
 

VI. MAXIMUM POWER POINT TRACKING 
 

Maximum power point tracking (MPPT) is a technique that grid connected inverters, solar battery chargers and 
similar devices use to get the maximum possible power from one or more photovoltaic devices, typically solar 
panels, though optical power transmission systems can benefit from similar technology. Solar cells have a complex 
relationship between solar irradiation, temperature and total resistance that produces a non-linear output efficiency 
which can be analyzed based on the I-V curve. It is the purpose of the MPPT system to sample the output of the cells 
and apply the proper resistance (load) to obtain maximum power for any given environmental conditions. MPPT devices 
are typically integrated into an electric system that provides voltage or current conversion, filtering, and regulation for 
driving various loads, including power grids, batteries, or motors. 
I-V curve 

 
 
 
Solar cell I-V curves where a line intersects the knee of the curves where the maximum power point is located. 
Photovoltaic have a complex relationship between their operating environment and the maximum power they can 
produce. The fill factor, abbreviated FF, is a parameter which characterizes the non-linear electrical behavior of the solar 
cell. Fill factor is defined as the ratio of the maximum power from the solar cell to the product of Open Circuit Voltage 
Voc and Short-Circuit Current Isc. In tabulated data it is often used to estimate the maximum power that a cell can 
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provide with an optimal load under given conditions, P=FF*Voc*Isc. For most purposes, FF, Voc, and Isc are enough 
information to give a useful approximate model of the electrical behavior of a photovoltaic cell under typical conditions. 
For any given set of operational conditions, cells have a single operating point where the values of the current (I) 
and Voltage (V) of the cell result in a maximum power output. These values correspond to a particular load resistance, 
which is equal to V / I as specified by Ohm's Law. The power P is given by P=V*I. A photovoltaic cell, for the majority 
of its useful curve, acts as a constant current source. However, at a photovoltaic cell's MPP region, its curve has an 
approximately inverse exponential relationship between current and voltage. From basic circuit theory, the power 
delivered from or to a device is optimized where the derivative (graphically, the slope) dI/dV of the I-V curve is equal 
and opposite the I/Vratio (where dP/dV=0). This is known as the maximum power point (MPP) and corresponds to the  

"knee" of the curve 

.  
IV curve 
 
A load with resistance R=V/I equal to the reciprocal of this value draws the maximum power from the device. This is 
sometimes called the characteristic resistance of the cell. This is a dynamic quantity which changes depending on the 
level of illumination, as well as other factors such as temperature and the age of the cell. If the resistance is lower or 
higher than this value, the power drawn will be less than the maximum available, and thus the cell will not be used as 
efficiently as it could be. Maximum power point trackers utilize different types of control circuit or logic to search for 
this point and thus to allow the converter circuit to extract the maximum power available from a cell, 
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VII.SYSTEM SPECIFICATION 
 

 
HARDWARE REQUIREMENTS 

 Personal Computer 
SOFTWARE REQUIREMENTS 

 MATLAB 2013 v 10.1 
 Windows 7 operating syste 

MATLAB: 
MATLAB is a high-performance language for technical computing. It integrates computation, visualization, and 
programming in an easy-to-use environment where problems and solutions are expressed in familiar mathematical 
notation. 
 
 APPLICATION DEVELOPMENT TOOLS 
  

 Modeling and Simulation 
 Image Processing 
 Signal Processing 
 Control System 
 Communications 
 Neural Network 
 Instrument Control 
 Aerospace 
 Fuzzy Logic 
 Embedded matlab 

 
 

MODELLING AND SIMULATION 
Matlab has several auxiliary Toolboxes distributed by Math works, Inc., which are useful in constructing 

models and simulating dynamical systems. These include the System Identification Toolbox, the Optimization Toolbox, 
and the Control System Toolbox. These toolboxes are collections of m-files that have been developed for specialized 
applications. There is also a specialized application, Simulink, which is useful in modular construction and real time 
simulation of dynamical systems. 

 
 SYSTEM IDENTIFICATION 
The System Identification Toolbox contains many features for processing experimental data and is used for testing the 
appropriateness of various models by optimizing values of model parameters. It is particularly useful in working with 
dynamical systems data and time series analyses. This toolbox is included in the Matlab installations on all the ITS 
servers. The identification process is a bit complex, but a guided tour through a simple example can be accessed with the 
iddemocommand at a Command Window prompt. 
 
Using Simulink: 
Simulink is a simulation tools library for dynamical systems. Any system in nature can roughly be thought of as a “black 
box” receiving an input vector u and eliciting a unique output vector y. In the case that both u and y vary with time we 
are talking about dynamic systems. 
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Associated with a system is the so-called state vector which loosely speaking contains the required information 

at time that together with knowledge of the input for time greater than, uniquely determines the output for . A general 
continuous dynamical system can be modeled by using the following set of ordinary differential and algebraic equations. 
 
 SIMULINK SUBSYSTEMS 

In Matlab programming, functions are used to encapsulate a computation so that it can be used repeatedly 
without having to duplicate code wherever it is needed. In addition, a function can insulate its calling script from having 
to worry about its implementation details. In Simulink, subsystems play a similar role. Using subsystems in Simulink 
has these advantages: 

 It helps reduce the number of blocks displayed in the model window. 
 Functionally related blocks can be kept together. 
 It permits the establishment of a hierarchical block diagram, wherein   a    Subsystem block is on one 

layer and the blocks that make up that subsystem are on another. 
In Simulink, a subsystem can be created in two ways: 

 One way is to add the blocks that make up the subsystem to the model, then group those blocks into a 
subsystem. 

 The other way is to first add a Subsystem block to the model, then   open that block and install the 
component blocks of the Subsystem to the subsystem window. 

 
Grouping existing blocks into a Subsystem: 
If a model already contains the blocks needed for a desired subsystem, you can create the subsystem by grouping those 
blocks: 

Enclose the blocks and connecting lines that you want to include in the  subsystem within a bounding box. For 
example, the figure below shows a model that does signal processing. The Abs, Sine Wave Function and Add blocks 
that do the signal conversions are selected within a bounding box. The box illustrated can be selected by clicking the 
mouse at the upper left position, and then while depressing the right mouse button drag to the lower right position. 

 

 
 

The components within the box will be selected when the mouse button is released.ChooseCreate Subsystem 
from the Edit menu. Simulink replaces the selected blocks with a Subsystem block. The figure below shows the model 
after the Create Subsystem command has been chosen. If necessary, the Subsystem block can be resized so that the port 
labels are readable). 
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Creating a Subsystem by adding a Subsystem block: 
The process of creating a subsystem before adding its component blocks usually consists of three major steps: 
1. Copy the Subsystem block from the Ports & Subsystems library into your model. 
2. Open the Subsystem block by double-clicking it. Simulink opens the subsystem in the current or a new model 
window, depending on the model window reuse mode that you selected. 
3. In the empty Subsystem window, create the subsystem. Use Inport blocks to represent input from outside the 
subsystem and Outport blocks to represent external output. 
 
Here is an example which models an integrator system: 
1. From the Simulink Library Browser, go to the Ports & Subsystems subdirectory.Click-drag the Atomic Subsystem 
block into the Model window. 
2. Open the subsystem block by double-clicking the subsystem block. 
3. Delete the line connecting In1 block and Out1 block. 
4. Insert blocks into this subsystem window as prescribed in the figure below and 
then fix the block layout and connections between blocks. 

 
5. Click on the Go to parent system button or choose View > Go to the Parent from the navigation bar. This will send 
you back to the underlying Model window. 
6. Go back to the Simulink Library Browser and add sine wave function and scope blocks into the Model window as 
described below. 
 
7. Run the simulation by clicking the Start button on the toolbar or by selecting   Simulation > Start from the navigation 
bar. Results can be seen by double clicking on the scope block 
 

VIII. CONCLUSION 
 
A new multiinputmultioutput dc–dc boost converter with unified structure for hybridizing of power sources in electric 
vehicles is proposed in this paper. The proposed converter has just one inductor. The proposed converter can be used for 
transferring energy between different energy resources such as FC, PV, and ESSs like battery and SC. In this paper, FC 
and battery are considered as power source and ESS, respectively. Also, the converter can be utilized as single input 
multioutput converter. It is possible to have several outputs with different voltage levels. The converter has two main 
operation modes which in battery discharging mode both of input sources deliver power to output and in battery 
charging mode one of the input sources not only supplies loads but also delivers power to the other source (battery). For 
each modes, transfer functions matrices are obtained separately and compensators for closed loop control of the 
converter is designed. It is seen that under various conditions such as rapid rise of the loads power and suddenly change 

http://www.ijareeie.com


 
                               
                                ISSN (Print)  : 2320 – 3765 
                                ISSN (Online): 2278 – 8875 

 

International Journal of Advanced Research in  Electrical, 
Electronics and Instrumentation Engineering 

(A High Impact Factor, Monthly, Peer Reviewed Journal) 

Website: www.ijareeie.com  

Vol. 7, Issue 3, March 2018 
 

Copyright to IJAREEIE                                                         DOI:10.15662/IJAREEIE.2018.0703033                                           1252  

of the battery reference current, output voltages and battery current are regulated to desired values. Outputs with 
different dc voltage levels are appropriate for connection to multilevel inverters. In electric vehicles, using of multilevel 
inverters leads to torque ripple reduction of induction motors. Also, electric vehicles which use dc motors have at least 
two different dc voltage levels, one for ventilation system and cabin lightening and other for supplying electric motor. 
Moreover, in grid connection of renewable energy resources like PV, using of multilevel inverters is useful. Finally, 
operation of this converter was experimentally verified using low-power range prototype. 
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